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Highlights 

 Thermal characterization of binary blends of metal stearates was performed. 
 Blends melted at lower temperatures and featured lower melt viscosities. 
 The metal stearates co-crystallised instead of forming eutectic mixtures. 
 Metal stearate blends imparted lower melt viscosity to chalk-filled polyethylene. 
 Particle agglomeration was reduced and particle dispersion was improved. 

 

Abstract 

Metal stearate blends are potential lubricants and filler dispersants in polymer compounding. 

Therefore, the thermal phase behaviour of binary blends of calcium stearate and magnesium 

stearate with zinc stearate was investigated. Cooling curve studies indicated lower melting 

temperatures in both systems. X-ray diffraction studies revealed that this was due to the 

formation of solid solutions of variable composition rather than to eutectic formation. 

Rheology measurements showed that true fluidification only happened well above the 

apparent melting points established from cooling curves. Calcium carbonate filled 

polyethylene containing metal stearate mixtures showed lower melt viscosities than were 

achievable using only calcium- or magnesium stearate as the lubricant. These results suggest 

that metal stearate blends, in combination with a judiciously selected wax component, may 

offer advantages in lowering compound melt viscosity and facilitating better particle 

dispersion. 
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1 INTRODUCTION 

The metallic stearates, zinc stearate (ZnSt), calcium stearate (CaSt) and magnesium stearate 

(MgSt), serve as multipurpose polymer additives [1]. They are used as antacids in polyolefins 

[1], as co-stabilisers in PVC formulations [2, 3], as general mould release agents [4] and also 

as lubricants [5, 6]. Compared to other metallic stearates, zinc stearate appears to be the most 

effective lubricant for many applications including polymers [3, 4].  

 

Metal stearates are also effective dispersants for inorganic fillers such as calcium carbonate. 

This is probably due, in part, to filler surface modification that renders it compatible with the 

hydrophobic polymer, e.g. linear low-density polyethylene (LLDPE). This facilitates the 

break-down of particle agglomerates and dispersion of individual particles in the polymer 

matrix [7]. This is a dynamic process that involves diffusion of the dispersants into the 

cavities of particle agglomerates. It reduces the shear forces required for disintegration and 

dispersion of the individual filler particles during the compounding process. A lubricant 

system with a lower melt temperature, i.e. a reduced fluidisation temperature could assist this 

process. Binary mixtures of compounds do show such reductions in melting behaviour, most 

commonly due to eutectic formation. Therefore, it was of interest to determine whether this 

would also apply for mixtures of metal stearates.  

 

Combinations of calcium- and zinc stearates are used for heat stabilisation of PVC. The 

application of such mixtures as lubricants in filled polyolefin-based compounds has not yet 



 
 

been reported. Perhaps such mixtures may provide improved lubricant and filler particle 

dispersion properties in highly filled polymer compounds and masterbatches. As a first step 

towards exploring this possibility, the properties of binary combinations of zinc stearate with 

either calcium- or magnesium stearate were investigated. The thermal phase behaviour and 

the transition to a liquid state of such blends were investigated as they bear relevance to their 

performance as filler particle dispersants and also as lubricants and viscosity reduction agents 

in polymer compounding applications.  

 

2 MATERIALS AND METHODS 

2.1 Materials 

Technical grade samples of the metal soaps were procured. The magnesium stearate [CAS 

No. 557-04-0] (Product code: 415057) was obtained from Sigma-Aldrich. The calcium 

stearate grade SAK-CS [CAS no. 1592- 23-0] and zinc stearate grade SAK-ZS-TGF [CAS 

no. 557-05-1] were supplied by Sun Ace.  

 

Sasol supplied a proprietary experimental Fischer-Tropsch wax (F-T wax) and linear low-

density polyethylene (LLDPE) grade HM2420. The density of the latter was 924 kgm3 and 

the melt index was 20 g/min @ at 190°C/2.16 kg. Safripol supplied HDPE Safrene M9255F. 

The density of this film blowing grade was 953 kgm3 and the melt flow rate was 0.3 g/min 

@ 190°C/5 kg.  Serina supplied stearic acid-coated calcium carbonate grade Ascom 50T. 

According to the supplier, the mean particle size was 2.2 µm. 

 

2.2 Methods 

2.2.1 Material preparation 

The following calcium carbonate-filled LLDPE compound formulation was used in order to 

obtain a preliminary indication of the lubrication effect imparted by the metal stearates: 

LLDPE (39.3 wt.%); Calcium carbonate (30 wt.%); wax (23.0 wt.% Sasol F-T wax) and 

metal stearate (7.7 wt.%). The low melt viscosity combination of polyethylene with Sasol F-T 

wax was chosen as this made the filled compound more amenable for evaluation on the plate-

plate rheometer. Compounding was performed on a ThermoFischer TSE 24 co-rotating twin-

screw compounder (24 mm ϕ, 30 L/D). Based on past experience, the screw speed was set at 

80 rpm and the temperature profile, from hopper to die, was 60/110/140/170/170/170/170 °C. 
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2.2.2 Film blowing 

The HDPE films, with 10 % add-on of the prepared calcium carbonate masterbatches, were 

blown on a Collin BL 180/400 blown film unit. It comprised a 30 mm  single screw extruder 

with L/D = 25. The extruder die had a diameter of 60 mm and featured a dual-lip cooling ring. 

The extruder was operated at a screw speed of 70 rpm. Stable film production was attained 

when the temperature profiles, from hopper to die, were set at 

190/190/195/195/195/195/220/220 °C. 

 

2.2.3 X-ray diffraction methodology 

X-ray diffractograms were recorded on a Bruker D2 PHASER instrument using Cu Kα 

radiation (λ=1.54060). The system was equipped with a LYNXEYE_XE-T detector with an 

up to 4.99° PSD opening. Samples were run as pressed powder pellets and scanned from 1 

to 50 2 at a rate of 0.02 2 steps per second.  

 

2.2.4 Differential scanning calorimetry (DSC) 

DSC was performed on a Perkin Elmer Pyris 4000 Instrument. Samples of the metal 

stearates, weighing 8  1 mg were placed in aluminium pans covered with a lid with a pin-

hole. The temperature was scanned from 20 C to 200 C at a rate of 10 Cꞏmin1 with 

nitrogen flowing at a rate of 20 mLꞏmin1.  

 

2.2.5 Thermogravimetric analysis (TGA) 

TGA was performed on a TA Instruments SDT-Q600 Simultaneous TGA/DSC instrument. 

Samples weighing ca. 8  1 mg were placed in 70 µL alumina cups. The temperature was 

scanned from 20 C to 700 C at a rate of 10 Cꞏmin1 with nitrogen flowing at a rate of 20 

mLꞏmin1.  

 

2.2.6 Energy Dispersive Spectroscopy (EDS) 

A Supra 55VP Field Emission scanning electron microscope fitted with an Oxford energy 

dispersive spectroscopy (EDS) system was used to visualise the size and distribution of 

CaCO3 aggregates within intact films. The analysis of carbon coated polymer films was 

performed side-on, at 25 kV and collecting 300k counts for quantitative EDS spectra, and 

over 500k for each X-ray map. The choice of such high accelerating voltage aimed to probe 

the polymer film sub-surface to a depth in excess of 4.5 µm [8]. Since the calcium-containing 



 
 

particles were roughly 2 µm in diameter, this depth would have revealed up to about three 

layers of particles in the 5 µm depth interrogated by the SEM beam. 

 

Elemental map images were opened in ImageJ, calibrated by drawing a line over the scale bar 

and entering 50 in the Analyze>Set Scale>Known Distance dialogue box). Images were 

segmented (Image>Adjust>Color Segmentation) using the default setting in the Color 

Thresholding RGB (ticking Red channel only and “Dark Background” options). The 

threshold areas were “Selected” in the Threshold Colour Panel, the image was converted to a 

binary image (Process>Binary>Make Binary), the “Fill holes” algorithm was applied 

(Process>Binary>Fill Holes), followed by “Analyze Particles” (Analyze>Analyze Particles), 

which generated a set of numbered outlines. From this the Feret diameter was extracted as the 

measure of the size of the CaCO3 deposits. Results were exported to Excel and subjected to 

an F-test (to explore if they had equal or unequal variances) and by a t-test to determine 

whether the sample means were statistically different from each other. 

 

2.2.7 Rheology 

The rheological experiments were performed on an Anton Paar MCR301 rheometer with a 

Peltier heating attachment. The experiments were performed with a 50 mm parallel plate 

configuration and a gap setting of 1 mm. The metal stearate samples were melted at 180 C 

and squeezed to a gap setting of 1 mm. The sample was pre-sheared for 1 minute at a shear-

rate of 5 s1 followed by 1 minute of rest. The temperature was then scanned from 180 C to 

60 C and then back up to 180 C at a scan rate of 5 Cmin1. This was done in oscillation 

mode at a frequency of 10 rads1 and a strain of 0.5 %. The normal force was controlled at 0 

N.  

 

Rheological measurements on the calcium carbonate-filled polyethylene samples were 

obtained with a frequency sweep from 0.2 rads1 to 200 rads1. The sample oscillation was 

specified at a fixed strain of 0.05%. The temperature was controlled at 170 C. 

 

2.2.8 Optical microscopy 

Microscopy experiments were conducted on a Leica DM2500M optical microscope 

connected to a Leica DFC420 digital camera. The optical micrographs were obtained under 

polarised light with a 1 λ retarder plate. The microscope was operated with a Linkam 
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Scientific CSS450 heating stage. The samples were crushed between a glass slide and the 

glass surface of the stage. The temperature was scanned from 30 C to 180 C at a heating 

rate of 10 Cmin1 after which the molten material was squeezed to remove most of the 

trapped air bubbles. The temperature was then reduced from 180 C to 30 C at a cooling rate 

of 10 Cmin1 in order to observe the crystallization. The samples were held isothermally for 

1 min at 10 C temperature halts during both the heating and cooling cycles to allow for 

temperature equilibration. Occasionally this interval was changed to 5 C based on 

observations made during the experiments. Micrographs were captured at the intervals after 1 

minute of rest at 2.5, 10 and 20 magnification. 

 

2.2.9 Cooling Curves 

Solid lubricant samples weighing 5.0 g were used for the cooling curve experiments. These 

samples were well mixed and mixtures were prepared using 10 wt.% increments. The solid 

material was added to a test tube and heated in a silicone oil bath on a Dathan Scientific MSH 

20D hotplate stirrer. The temperature was adjusted until all the solids were molten. A 

temperature probe, attached to a Hairuis SSN-61 data logger, was placed in the sample. The 

temperature was logged every 2 seconds as the sample was allowed to freely cool down to 50 

C. Undercooling and temperature rebound was monitored to identify the apparent melting 

temperature. 

 

3 RESULTS AND DISCUSSION 

The commercial metal soaps, used presently, are actually complex mixtures of salts of several 

different fatty acids. They consist mainly of stearic acid and palmitic acid with the total 

amount of these acids being at least 90 % [9]. Unfortunately, the suppliers did not disclose 

the composition of the actual products used in this investigation. For calculation purposes, it 

was assumed that the samples all contained 65 wt.% metal stearate and 35 wt.% of the metal 

palmitate.  

 

The calcium and magnesium stearates may exist in multiple crystal forms associated with 

different degrees of hydration. Figure 1 shows the mass loss curves of the neat metal stearates 

obtained in a nitrogen atmosphere. The mass loss recorded at a temperature of 150 C 

provides an indication of the moisture content or the amount of water of hydration present. 

The mass loss of 0.2 wt.% for the zinc stearate probably represents adsorbed moisture. The 



 
 

2.9 wt.% mass loss found for calcium stearate is close to that expected for the monohydrate 

(3.0 wt.%). The recorded mass loss for the magnesium stearate (4.1 wt.%) suggests that the 

neat product was a mixture of the mono hydrate and the dihydrate. The expected mass loss 

values for those two forms are 3.1 wt.% and 5.9 wt.% respectively. Figure 1 also reveals that 

the thermal stability of the three soaps decreased in the order of the metal ion present 

according to the series calcium > zinc > magnesium stearate. 

 

Figure 1. Thermogravimetric analysis of the neat stearates in a nitrogen atmosphere 

 

Figure 2 reports the X-ray diffraction patterns of the metal stearates recorded at ambient 

temperature. It shows diffractograms obtained for the as-received powders and also after a 

heat-treatment at 180 C, i.e. an exposure to a temperature higher than the melting points. 

The diffraction patterns of the calcium and zinc stearates are approximately the same for the 

neat and the heated forms. The only difference is that the reflections of the latter forms are 

slightly broader, indicative of reduced crystalline perfection. The diffractogram for the neat 

magnesium stearate is consistent with the dihydrate form. However, the diffraction pattern of 

the heat-treated magnesium stearate differed significantly from that of the neat sample. 
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Figure 2. X-ray diffractograms recorded for the neat metal stearates as received and after a heat treatment at 

180 C (indicated by (m) for melted samples).  

 

 

Figure 3. X-ray diffractograms for binary mixtures of zinc stearate with (a) calcium stearate, and (b) 

magnesium stearate. All the diffractograms were recorded after the mixtures were mixed at 180 C and allowed 

to cool down to ambient temperature. 

 

Figure 3(a) shows the XRD diffractograms for the binary calcium/zinc stearate blends. From 

0 wt.% to 80 wt.% zinc stearate the diffraction patterns are similar to those observed for the 

calcium stearate. This suggests that the two metal stearates co-crystalize. As revealed in 

Figure 4, the d-spacing remained constant at 4.82  0.06 nm. This is consistent with the zinc 



 
 

stearate being progressively incorporated into a calcium stearate-defined lattice. The 

formation of this multicomponent crystal phase is doubtless facilitated by the smaller ionic 

radius of Zn2+ ions (74 pm) compared to the radius of Ca2+ ions (114 pm). This makes it easy 

for a zinc ion to replace a calcium ion in the crystal lattice. 

 

Figure 4. Variation of the d-spacings corresponding to the migrating reflections, at angular range 1 to 3 2, 

with zinc stearate content of the binary metal stearate blend.  The labels (a) and (b) refer to d-spacings 

corresponding to the first two reflections observed in the magnesium stearate-zinc stearate blends. 

 

Figure 3(b) shows the XRD patterns for the binary magnesium/zinc stearate blends. Figure 4 

shows a plot of the d-spacings as a function of blend composition. The d-spacing of the neat 

zinc stearate is 4.29 nm. As the magnesium content was increased to 40 wt.% the d-spacing 

increased approximately linearly. Beyond 50 wt.% magnesium stearate content, the angle 

corresponding to this reflection remained approximately constant corresponding to a d-

spacing of 5.10  0.10 nm. This is lower than the d-spacing of the neat hydrated magnesium 

stearate, i.e. 5.49 nm. However, it does mean that the presence of even minor amounts of zinc 

stearate assists the formation of a crystalline phase similar to that of a different dehydrated 

magnesium stearate. Coming from the opposite side of the composition range, one observes 

that the main reflection of the dehydrated magnesium stearate is also observed in blends 
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containing up to 50 wt.% zinc stearate. The d-spacing corresponding to this reflection is 3.15 

 0.04 nm. This means that the XRD data indicate that at least two different phases are 

present below a zinc stearate content of about 50 wt.%. Furthermore, the XRD results are also 

consistent with co-crystallization occurring at higher zinc stearate content.  

 
Figure 5. Differential scanning calorimetry calcium/zinc stearate blends showing the variation of the melting 

behaviour with composition. 

 

Figure 5 shows the DSC heating endotherms found, during heating scans, for previously 

melted and solidified calcium stearate, zinc stearate and selected blends. Both the calcium 

and the zinc stearate show well-defined, single-event endotherm peaks. The peak 

temperatures were 128.3 C and 124.5 C for the neat calcium- and the neat zinc stearate 

samples respectively. In all the blend samples, the endotherms peaks are shifted to 

significantly lower temperatures. The sample containing 20 wt.% zinc stearate also featured a 

single endotherm peak but a shoulder is noticeable at the lower temperature side. In the blend 

containing 40 wt.% zinc stearate, this endothermic event developed into a separate peak 

located at 101.1 C. Multiple endotherms event are indicated by the peaks and shoulders 

visible in the samples containing 60 wt.% and 80 wt.% zinc stearate. The presence of 

multiple endothermic events does not necessarily invalidate the deductions made on the basis 

of the XRD results. This is because rotator phase transitions and mesophase formation are 

also endothermic events [10]. 



 
 

Figure 6 shows the DSC endotherms observed on heating samples of the magnesium-zinc 

stearate binary system. Compared to the other two metal soaps, magnesium stearate (MgSt) 

shows highly complex thermal phase behaviour [9, 10]. According to Haware, Vinjamuri, 

Sarkar, Stefik and Stagner [10], the thermal transitions observed during the first heating cycle 

of hydrated forms are irreversible. Thereafter, complex cool-heat-cool-heat DSC 

thermograms are reproducible and exhibit up to six reversible exothermic-endothermic 

conjugate pairs [10]. These include five distinct mesophases stable at different temperatures 

with one phase persisting up to 250 °C. Curiously, molecular ordering was maintained 

beyond 276 °C implying that magnesium stearate does not undergo a simple melting 

phenomenon [10]. Similar observations were made in the present investigation.  

 
Figure 6. Differential scanning calorimetry magnesium stearate – zinc stearate blends showing the variation in 

the nature of the endothermic events with composition 

 

Unlike the zinc stearate, the melting thermogram for the magnesium stearate considered 

presently, featured multiple endotherms. The first endotherm of the anhydrous form is 

probably due to a transformation into a rotator structure while those occurring at higher 

temperatures correspond to the melting of this phase and finally the transformations into an 

inverse micelle phase [11]. Three endotherm peaks, shifted to lower temperatures, are also 

observed when just 10 wt.% zinc stearate is present. However, the sample containing 40 wt.% 

zinc stearate featured only two endotherms. Their peak temperature positions agreed well 
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with the first and third endotherm of the sample with 10 wt.% zinc stearate. Samples 

containing even more zinc stearate featured multiple endothermic events as distinct peaks or 

as shoulders.   

 

 
Figure 7. Estimating the temperature associated with the onset of melt fluidity from plots of the complex 

viscosity:  viscosity: Blends of zinc stearate with (a) calcium stearate and (b) with magnesium stearate. The 

measurements reflect data obtained during a heating scan and the curves were shifted vertically to a common 

plateau value of 80 kPas in the temperature range 70 C to 90 C. 

 

Figure 7 shows shifted complex viscosity curves for neat metal stearate and their binary 

blends. The low-temperature plateau values reflect the rheological behaviour of the solid 

state. Unfortunately, the complex viscosity values in this range showed considerable scatter 

whereas the onset temperatures for melt fluidity were reproducible. In order to make the latter 

easier to perceive, all the curves were shifted vertically to a common plateau value 80 kPas. 

Figure 7(a) shows the data for the calcium-zinc stearate binary system. All the blends became 

fluid at temperatures lower than the two parent compounds, i.e. 120 C and 141 C for zinc- 

and calcium stearate respectively. The lowest fluidification temperature (96.5 C) was found 

for the blends containing 60 wt.% zinc stearate. This correlates well with the DSC results 

curves which also show that this mixture has the lowest observed melting endotherm. 

 

Figure 7(b) shows the corresponding curves for the magnesium-zinc stearate binary. This 

system showed more complicated behaviour. Most blends liquified at temperatures between 

120 C and 151 C, i.e. the fluidification temperatures associated with the parent zinc- and 



 
 

magnesium stearate respectively. The exceptions were the blends containing 35 wt.% and 40 

wt.% zinc stearate. These two mixtures had fluidification onset temperatures lower than that 

of the neat zinc stearate. Actually, diluting the magnesium stearate with up to 30 wt.% zinc 

stearate did not change the fluidification temperature materially. Similarly, addition of up to 

20 wt.% calcium stearate did not change the fluidification temperature from that observed for 

the neat zinc stearate. The lowest fluidification temperature (106.5 C) was obtained with a 

blend containing 65 wt.% zinc stearate. 

 

Figure 8 compares the fluidification onset temperatures to the apparent melting temperatures 

deduced from the cooling curves. All the curves show a minimum located around 60 or 

65 wt.% zinc stearate. However, there is a major difference in that the apparent melting 

temperatures, inferred from the halts in the cooling curves, are significantly lower that the 

fluidification onset temperatures obtained from the rheological studies.   

 

 
Figure 8. Fluidification temperatures from rheology measurements compared to apparent melting temperatures 

obtained from cooling curves. 

 

The minima in the apparent melting- and fluidification temperatures are reminiscent of 

eutectic formation. However, the XRD diffraction results showed that the metal stearates co-

crystallised. Conventional co-crystallisation leads to the formation of a complex with a fixed 
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composition ratio for the constituents. The melting curves in the phase diagrams of such 

systems are usually W-shaped corresponding to the formation of two eutectics, each with the 

complex participating with one of the parent compounds [12]. This feature is not shown by 

the present data. This is attributed to the fact that co-crystallisation occurred over a wide 

range of compositions, i.e. it led to the formation of solid solutions.  

 

Optical microscopy results, obtained under polarised light, are presented in more detail in the 

Supplementary material. It discusses the microstructure evolution in the melts when cooling 

from 180 C to ambient. Figure 9 shows micrographs for the solidified neat zinc stearate and 

a blend containing 35 wt.% magnesium stearate. Figure 9a shows that, upon cooling the neat 

zinc stearate melt, nucleation lead to polycrystalline growth patterns of a spherical shape, i.e. 

spherulites. According to Gránásy, Pusztai, Tegze, Warren and Douglas [13], such spherulitic 

growth patterns arise “from the competition between the ordering effect of local 

crystallographic symmetries and the randomization of the local crystallographic orientation 

that accompanies crystal grain nucleation at the growth front”. These spherulites grew to 

about 250 μm in size before they impinged on neighbouring spherulites. The calcium stearate 

showed very different behaviour. There was evidence for the gradual development of 

texturing almost to fine-scaled to discern with the available equipment. It is possible that the 

observed change in texturing was due to the nucleation and growth of countless crystals that 

were too small to be observable at the 20 magnification in the optical microscope. The 

complex thermotropic behaviour exhibited by magnesium stearate [10] was not resolved in 

the present optical microscopy study and the cooled solid was featureless.  

 

Figure 9b shows a micrograph recorded for the 35/65 magnesium/zinc stearate mixture. The 

granulated microstructure shows strong local orientation under polarised light. It probably 

arose from extensive nucleation that resulted in spherulites less than 50 μm in size. The 

smaller size of the spherulites implies that there is also more interfacial area between them 

where there is a mismatch in crystalline orientations. It can be speculated that this might have 

contributed to the lower fluidification temperature of this blend. 

 

 



 
 

 
 

Figure 9. Optical micrographs, under polarised light, of the solids obtained after cooling the melts of (a) neat 

zinc stearate and (b) the 35/65 magnesium/zinc stearate blend. 

 



  

16 
 

 

Figure 10. The effect of the metal stearate lubricants on the complex viscosity of 30 wt.% calcium carbonate 

compounds. Sasol F-T wax was added to the polyethylene matrix in order to lower the melt viscosity of the 

compounds.  

 

The rheology data presented above indicates that mixtures of zinc stearate with either 

magnesium- or calcium stearate feature a lower fluidification temperature than the latter two 

lubricants. In theory, this should assist early wetting of a filler component, break-up of 

particle agglomerates and dispersion of individual particles into the matrix during a 

compounding process. Ultimately this should lead to filled compounds with a lower apparent 

viscosity. In order to test this hypothesis, 30 wt.% filled calcium carbonate compounds were 

prepared. Figure 10 shows rheology results obtained at 170 C for a range of compounds in 

which the natures of both the wax component and the lubricants were varied. The measured 

viscosities were similar irrespective of the wax employed but showed significant variation 

depending on the nature of the metal stearate employed. All the compounds showed shear 

thinning behaviour over the frequency range 2 to 200 rads1.  Those compounds based on 

neat calcium- or magnesium stearate feature a significantly higher complex viscosity than the 

compounds based on neat zinc stearate. Cutting back the zinc stearate, by replacing a one-

third portion with one of the other metal stearates, had only a minor effect on the melt 

viscosity.  



 
 

Figure 11 shows representative images that provide qualitative information about the 

distribution of the calcium carbonate particles near the surface of the blown films prepared by 

adding either neat magnesium stearate (Figure 11a) or a blend of magnesium stearate with 

zinc stearate (Figure 11b). Particle agglomerates were present in all the film samples. In 

Figure 11a there are ten large red spots representing particle agglomerates. Two of them are 

quite large. In Figure 11b only six such spots are visible and they appear to be smaller in size. 

In addition, there are many smaller red dots in Figure 11b that are of a size expected for the 

individual calcium carbonate particles.  

 

 
Figure 11. EDS visualisation of the dispersion of calcium carbonate particles near the polymer film surfaces. (a) 

Magnesium stearate as lubricant, and (b) a blend of magnesium- and zinc stearate as lubricants. The smallest 

dots indicate the presence of primary calcium carbonate particles and the larger red spots are due to large-scale 

particle agglomerates. 

 

Figure 12 shows a plot of the ImageJ results. It shows that in the sample based on magnesium 

stearate as the lubricant the particle sizes extended over a wide range, with large clumps 

measuring up to 13 m in diameter. This is reflected in the larger mean Feret diameter and 

larger standard deviation, i.e. 2.69  2.42 m. The corresponding values for the film made 

using the metal stearate blend were 2.08  1.19 m. The F-test and the t-test returned highly 

significant alpha values, confirming significant (p > 0.001) differences between these 

populations. These observations suggest that the metal stearate blend was more effective at 

breaking down agglomerates and facilitating the dispersion of individual CaCO3 particles in 

the polymer matrix. The implication is that the reduced melt viscosities, observed for the zinc 

stearate as lubricant, can in part, be attributed to improved particle dispersion in the 

composites. While these preliminary results are encouraging, more work is required to 

confirm and quantify any advantage of using blends of zinc stearate with either calcium or 
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magnesium stearate as a lubricant package in filled polymer compounds. In particular, the 

performance in compounds containing much higher filler levels should be investigated. Such 

efforts are currently under way. 

 

 
Figure 12. Particle Feret size distribution inferred from ImageJ analysis of the images shown in Figure 11. 

 

4 CONCLUSIONS 

Binary mixtures of zinc stearate with magnesium stearate and calcium stearate were 

investigated as possible alternative lubricants for polymer processing. It was hypothesised 

that these systems would form low melting eutectics which would improve filler dispersion. 

However, X-ray diffraction results indicated that both systems formed co-crystallised 

forming solids solutions with variable compositions as opposed to eutectic mixtures. In the 

calcium/zinc stearate system, it was observed that the zinc ions form part of the calcium 

stearate crystal lattice even at compositions of only 20 wt.% calcium stearate. The 

magnesium stearate system behaved differently. The low magnesium stearate compositions 

showed an increasing d-spacing as the magnesium stearate content was increased. This 

continued up to 50 wt.% magnesium stearate. At even higher magnesium stearate content, 

two sets of reflections were identified, indicating the presence of two phases for the 



 
 

dehydrated stearates. No significant difference was observed for calcium stearate and zinc 

stearate. A major shift to higher reflections was identified for the magnesium stearate. 

 

The mixtures of lubricants were investigated via DSC and cooling curves. They showed 

lower melting points compared to the pure components. The lowest being about 66 C for the 

40 wt.% magnesium stearate sample and about 82 C for 40 wt.% calcium stearate sample. 

Multiple endothermic peaks and shoulders were identified for all the mixtures. Some of the 

peaks can probably be attributed to a rotator phase transition of the mesophase.  

 

The lowering of the melting point of these mixtures also resulted in a lower melt viscosity. 

Rheology of the calcium stearate mixtures showed reduced fluidification temperatures for all 

of the samples. The magnesium stearate system behaved differently, where samples behaved 

as either magnesium stearate dominant, zinc stearate dominant, or what is believed to be the 

cocrystal structure dominated system. Of the latter, two samples showed reduced 

fluidification temperatures compared to the pure zinc stearate. 

 

These results would indicate the possibility of improved lubrication and dispersion of fillers 

for masterbatch compositions. An example of this was shown where 1:2 weight ratio of zinc 

stearate to magnesium or calcium stearate gave similar complex viscosity measurements to 

that of the industry standard zinc stearate.  

 

CRediT authorship contribution statement 

Justin Phillips: Conceptualization, Data curation, Formal analysis, Investigation, 
Methodology, Project administration, Software, Supervision, Validation, Visualization, 
Writing - original draft, Writing - review & editing. Michelle Weldhagen: Data curation, 
Formal analysis, Investigation, Methodology, Writing - original draft. Thobile Mhlabeni: 
Conceptualization, Data curation, Formal analysis, Investigation, Methodology, Resources, 
Software, Supervision, Writing - original draft. Lucky Radebe: Data curation, Formal 
analysis, Investigation, Methodology, Project administration, Writing - original draft. Shatish 
Ramjee: Conceptualization, Data curation, Formal analysis, Investigation, Methodology, 
Resources, Supervision, Validation, Visualization, Writing - original draft, Writing - review 
& editing. James Wesley-Smith: Conceptualization, Data curation, Formal analysis, 
Investigation, Methodology, Resources, Software, Validation, Visualization, Writing - review 
& editing. Maria Atanasova: Conceptualization, Data curation, Formal analysis, 
Investigation, Methodology, Resources, Software, Validation, Visualization, Writing - 
original draft, Writing - review & editing. Walter W. Focke: Conceptualization, Formal 
analysis, Funding acquisition, Investigation, Methodology, Project administration, Resources, 
Supervision, Validation, Visualization. 



  

20 
 

Declaration of Competing Interest 

The authors declare that they have no known competing financial interests or personal 
relationships that could have appeared to influence the work reported in this paper. 

 

Acknowledgement 

Financial support for this research from Sasol is gratefully acknowledged. The authors 

express their thank to Mr Theuns van Schalkwyk of Ferro Industrials Products for assisting 

with the obtaining of samples of some of the raw materials. 

 

REFERENCES 
[1] R.L. Sherman, Jr., Use and utility of metal soaps in polyolefins, in:  Annual Technical Conference - ANTEC, 
Conference Proceedings, 2018. 
[2] K.B. Abbås, E.M. Sörvik, Heat stabilizers for poly (vinyl chloride). I. Synergistic systems based on 
calcium/zinc stearate, Journal of Vinyl Technology, 2 (1980) 87-94. 
[3] E.S. Lower, Zinc stearate: its properties and uses, Pigment & Resin Technology, 11 (1982) 9-14. 
[4] J.G. Bilek, V. Kollonitsch, C.H. Kline, Zinc chemicals in plastics systems, Industrial and Engineering 
Chemistry, 58 (1966) 28-36. 
[5] S. Lower Edgar, Magnesium stearate: A review of its uses in paints, plastics, adhesives and related industries, 
Pigment & Resin Technology, 10 (1981) 7-25. 
[6] S. Lower Edgar, Calcium stearate in resins and resinous polymers: part 1, Pigment & Resin Technology, 25 
(1996) 24-29. 
[7] W.W. Focke, D. Molefe, F.J.W. Labuschagne, S. Ramjee, The influence of stearic acid coating on the 
properties of magnesium hydroxide, hydromagnesite, and hydrotalcite powders, Journal of Materials Science, 44 
(2009) 6100-6109. 
[8] J.I. Goldstein, D.E. Newbury, J.R. Michael, N.W.M. Ritchie, J.H.J. Scott, D.C. Joy, Scanning Electron 
Microscopy and X-Ray Microanalysis, Springer Science, 2018. 
[9] M. Koivisto, H. Jalonen, V.-P. Lehto, Effect of temperature and humidity on vegetable grade magnesium 
stearate, Powder Technology, 147 (2004) 79-85. 
[10] R.V. Haware, B.P. Vinjamuri, A. Sarkar, M. Stefik, W.C. Stagner, Deciphering magnesium stearate 
thermotropic behavior, International Journal of Pharmaceutics, 548 (2018) 314-324. 
[11] K. Wakabayashi, R.A. Register, Phase Behavior of Magnesium Stearate Blended with Polyethylene 
Ionomers, Industrial & Engineering Chemistry Research, 49 (2010) 11906-11913. 
[12] E. Stoler, J.C. Warner, Non-Covalent derivatives: Cocrystals and eutectics, Molecules, 20 (2015) 14833-
14848. 
[13] L. Gránásy, T. Pusztai, G. Tegze, J.A. Warren, J.F. Douglas, Growth and form of spherulites, Physical 
Review E, 72 (2005) 011605. 
 


